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This benchmark model computes the valence band structure of an unstrained and a
strained bulk GaN wurtzite crystal, as a tutorial for users who wish to set up multiple wave-
function components with the Schrédinger Equation interface. The model follows the
formulation given in the reference paper by Chuang and Chang (Ref. 1). The diagonal and
off-diagonal elements of the Hamiltonian matrix are entered using built-in features, with
detailed instructions in the model documentation. The computed eigenvalues agree well
with the analytic solution and Fig. 5 in the paper.

Introduction

For the Schrodinger Equation physics interface, if the wave function has more than one
component, then the Hamiltonian becomes a matrix. The number of elements of the
matrix grows as the square of the number of wave-function components. Each element can
include several terms of zero, one, or two partial derivatives. A number of built-in features
have been created to provide flexible and efficient ways to enter these terms into the

graphical user interface within limited window size.

Because the main purpose of this model is to illustrate the usage of these built-in features,
a particularly simple system of bulk GaN crystal is chosen for clarity. Specifically, the model
uses the upper left 3-by-3 matrix of the block-diagonalized 6-by-6 Hamiltonian for the
demonstration. Once you have understood the procedure for setting up this simple

Hamiltonian matrix, you should be able to build your own models of higher complexity.

An additional benefit of this simple system is that an analytic formula for the matrix
elements exists and the result from the solution of the Schrédinger Equation can be

compared against the eigenvalues of the 3-by-3 matrix equation with analytic coefficients.

Model Definition

Gallium nitride (GaN) is an important wideband-gap semiconductor material for
optoelectronics, high-power, and high-frequency applications. Chuang and Chang
published their derivation and computation of the 6-by-6 Hamiltonian matrix for wurtzite
crystals including GaN in 1996 (Ref. 1). In Eq. (45) of the paper, the 6-by-6 Hamiltonian
matrix is block diagonalized, and the upper left 3-by-3 matrix reads
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The matrix elements are given by Eqs. (34) and (42) in Ref. 1. To compare with Fig. 5 in
the paper, set the crystal momentum k&, to zero. For the Schrédinger Equation interface,
k, and k, are replaced by the partial derivatives 0/0x and i0/0z, respectively. Note that
there is no minus sign in front of the imaginary unit i because of the engineering sign
convention adopted by all COMSOL physics interfaces: a plane wave is exp(—ikx+iot),
not exp(ikx—iwt).

As an example of entering the matrix elements into the graphical user interface, consider
the element F at the (1,1) position of the 3-by-3 Hamiltonian matrix. Eq. (34) in the

paper gives

F=A1+A2+x+e (2)
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ks = Dlgzz+D2(gxx+8yy) (5)
9& = D3822+D4(8xx+8yy) (6)

In Equation 3 and Equation 4, the partial derivative on the left side is understood to
operate on both the A; coefficient and the wave function (not explicitly displayed on the
right end). In general, the A; coefficients and other material parameters can be spatially
varying, for example, in heterostructures or quantum dots. Here, for the simple case of a

bulk crystal, all of these parameters are constants.

The first terms in Equation 3 and Equation 4 involve second-order derivatives, while the
last terms A, and O, are strain-dependent constants given by the formulas Equation 5 and
Equation 6. The built-in features Second Order Hamiltonian and Zeroth Order Hamiltonian
(or Electron Potential Energy for diagonal elements) will be used to enter each type of terms

in the model, respectively, as detailed in the Modeling Instructions section.

Since the model solves for the bulk crystal, it suffices to create a small square domain
(smaller than the smallest wavelength of interest), and use the Floquet-Bloch periodic

boundary conditions. In this case, a small number of mesh elements is enough.

For the analytic solution, a global equation is used to set up the 3-by-3 matrix equation.

The All option of the Eigenvalue search method is used to obtain all 3 eigenvalues.
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Results and Discussion

Figure 1 and Figure 2 show the computed unstrained and strained heavy hole (HH), light
hole (LH), and crystal-field split-oft hole (CH) dispersions along the positive x-axis and

negative z-axis directions, agreeing well with analytic solution (circles) and Fig. 5 in Ref. 1.

Fig. 5. Unstrained
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Figure 1: Unstrained valence band structure of bulk GaN wurtzite crystol.
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Fig. 5. -1% Strained
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Figure 2: Strained valence band structure of bulk GaN wurtzite crystal.
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Figure 3 compares the 2D band energy surfaces along the x and z directions for the
3 valence bands between computed values (color surface) and analytic solution (gray
wireframe). The agreement is very good.
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Figure 3: Strained valence band structure of bulk GaN wurtzite crystal.
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Application Library path: Semiconductor_Module/Verification_Examples/
k_dot_p_method_strained_wurtzite_gan_band_structure

Modeling Instructions

From the File menu, choose New.

NEW
In the New window, click Model Wizard.
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MODEL WIZARD

|
2

N o 1 obh

In the Model Wizard window, click €@ 2D.
In the Select Physics tree, select Semiconductor > Schrodinger Equation (schr).
Click Add.

Since there are three valence bands of interest, set the number of wave function

components to 3.
In the Number of wave function components text field, type 3.
Click e Study.

In the Select Study tree, select Preset Studies for Selected Physics Interfaces > Eigenvalue.
Click E,/ Done.

GEOMETRY |
The Model Wizard ended at the Settings pane for the Geometry node in the Model Builder

tree structure. Use this opportunity to select a convenient length unit.

|
2
3

In the Model Builder window, under Component | (compl) click Geometry 1.
In the Settings window for Geometry, locate the Units section.

From the Length unit list, choose A.

The geometry can be a simple square for setting up the Floquet-Bloch boundary

conditions. The size of the domain should be smaller than the shortest wavelength, to

prevent spurious modes (a related mechanical model is

thin_film_baw_resonator_dispersion_diagram in the MEMS Module, where a narrow

domain is used).

Square | (sql)

|
2

In the Geometry toolbar, click ’j Square.

In the Settings window for Square, click [§2 Build All Objects.

This 2D model considers the valence band dispersion along the x and z directions. Change

the default second axis name from y to z for clarity.

COMPONENT I (COMPI)

|
2

In the Model Builder window, click Component | (compl).

In the Settings window for Component, locate the Frames section.
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3 Find the Spatial frame coordinates subsection. In the table, enter the following settings:

First Second Third

X z y

4 Find the Material frame coordinates subsection. In the table, enter the following
settings:

First Second Third
X Z Y

Enter the GaN material parameters as listed in Table III of Chuang and Chang’s paper.
Only the valence band parameters are needed for this model. First enter the energy
parameters Ay, Ay, Ag, Ag, and A.

GLOBAL DEFINITIONS

Parameters | - GaN

I In the Model Builder window, under Global Definitions click Parameters 1I.
2 In the Settings window for Parameters, type Parameters 1 - GaN in the Label text field.

3 Locate the Parameters section. In the table, enter the following settings:

Name Expression Value Description

Delt 16[meV] 2.5635E-21 | Energy parameters
Delso 12[meV] 1.9226E-21 )

Del2 Delso/3 6.4087E-22 |

Del3 4[meV] 6.4087E-22 |

Del sqrt(2)*Del3 9.0633E-22 |

Next enter the valence band effective-mass parameters A; ~ Ag.
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4 In the table, enter the following settings:

Name Expression Value Description
A1l -6.56 -6.56 Valence band effective mass
parameters

A2 -0.91 -0.91

A3 5.65 5.65

A4 -2.83 -2.83

A5 -3.13 -3.13

A6 -4.86 -4.86

Next enter the deformation potentials Dy ~ Dy.

5 In the table, enter the following settings:

Name Expression Value Description

D1 0.7[eV] I.1215E-19 ) Deformation potentials
D2 2.1[eV] 3.3646E-19 |

D3 1.4[eV] 2.243E-19 ]

D4 -0.7[eV] -1.1215E-19 ]

Next enter the elastic stiffness constants Cqg and Cggs.

6 In the table, enter the following settings:

Name Expression Value Description

Cc13 15.8e11[dyn/cm"2] 1.58EIl N/m? Elastic stiffness
constants

C33 26.7e11[dyn/cm"~2] 2.67E11 N/m?

Finally to prevent too long a list of parameters when setting up sweeps, exclude these

parameters from the selection list.

7 Click to expand the Visibility section. Clear the Show in parameter selections checkbox.
Now set up the swept parameters.

Parameters 2 - Sweeps
I In the Home toolbar, click Pi Parameters and choosc Add > Parameters.

2 In the Settings window for Parameters, type Parameters 2 - Sweeps in the Label text
field.
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3 Locate the Parameters section. In the table, enter the following settings:

Name Expression Value Description
epsxx -0.01 -0.01 Strain,xx
epsyy epsxx -0.01 Strain,yy
epszz -2*C13/C33*epsxx 0.011835 Strain,zz

To conveniently create a plot to compare with Fig. 5 in the paper, set up a swept
parameter kp such that its positive axis represents the kx axis and the negative axis

represents the kz axis.

4 In the table, enter the following settings:

Name Expression Value Description

kp O[rad/nm] 0 rad/m Positive axis: kx,
negative axis: kz

kx if (kp>0,kp,0[rad/nm]) 0 rad/m

ky O[rad/nm] 0 rad/m

kz if (kp<0,-kp,0[rad/nm]) O rad/m

For comparing with analytic solutions, enter the formulas from Eq. (34) and Eq. (42) in
the paper. These parameters also are not needed to be in the selection list. In these
formulas, the wave vectors kx and kz are numerical parameters. Therefore, a 3-by-3
Hermitian matrix can be constructed and diagonalized to provide the eigenvalues for
analytic comparison. Later on when setting up the Schrodinger equation, the wave vectors
kx and kz will be replaced by difterential operators, not just numbers. This distinction
should be kept in mind. First enter the diagonal parameters F, G, A, Ag, 6, and 6, in

Eq. (34).

Parameters 3 - Analytic formula
I In the Home toolbar, click Pi Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 3 - Analytic formula in
the Label text field.

3 Locate the Visibility section. Clear the Show in parameter selections checkbox.

10 | K-P METHOD FOR STRAINED WURTZITE GAN BAND STRUCTURE



4 Locate the Parameters section. In the table, enter the following settings:

Name Expression Value Description
F Deli+Del2+1m+th 2.7003E-21 | Eq. (34)
G Del1-Del2+1m+th 1.4186E-21 |

Im hbar_const~2/2/ -5.4018E-21 )

me_const* (A1*kz"2+A2*
(kx"2+ky~2))+1meps

lmeps D1*epszz+D2* (epsxx+ -5.4018E-21 )
epsyy)
th hbar_const~2/2/ 4.8977E-21 )

me_const* (A3*kz"2+A4*
(kx~2+ky~2))+theps

theps D3*epszz+D4* (epsxx+ 4.8977E-21 )
epsyy)

Then enter the oftf-diagonal terms K; and H; in Eq. (42).

5 In the table, enter the following settings:

Name Expression Value Description
Kt hbar_const~2/2/me_const*A5*kt"2 0] Eq. (42)
Ht hbar_const~2/2/me_const*A6*kt*kz -0]

kt sqrt(kx"2+ky~2) 0 rad/m

Set up a global equation to diagonalize the 3-by-3 Hermitian matrix - the upper-left

Hamiltonian in Eq. (45) in the paper. Use the reserved name lambda for the eigenvalue
in the global equation. Scale the Hamiltonian with the energy scale of 1 meV so that the
source term is about order of unity, and the eigenenergy is the eigenvalue in the unit of

meV. Add some blank spaces in the expressions to align the columns of the matrix.

ADD PHYSICS

I In the Home toolbar, click J: Add Physics to open the Add Physics window.
2 Go to the Add Physics window.

3 In the tree, select Mathematics > ODE and DAE Interfaces > Global ODEs and DAEs (ge).
4 Click the Add to Component | button in the window toolbar.

5 In the Home toolbar, click J: Add Physics to close the Add Physics window.
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GLOBAL ODES AND DAES (GE)

Global Equations | (ODEI)

I In the Settings window for Global Equations, locate the Global Equations scction.

2 In the table, enter the following settings:

Name f(u,ut,utt,t) (1) Initial value (u_0) (1) Initial value (u_t0) (1/s)
ui (F*utl+Kt*u2-i*Ht* 0 0
u3)/1[meV]-lambda*
ui
u2 (Kt*u1+G*u2+(Del- 0 0
i*Ht)*u3)/1[meV]-
lambda*u2
u3 (i*Ht*u1+(Del+i* 0 0

Ht) *u2+1m*u3)/
1[meV]-lambda*u3

The text is yellow colored because at this point the eigenvalue variable 1ambda is not
defined yet.

Set up the physics. Unlike the analytic formulas where everything is a number, here in the
Schrodinger equation the wave vectors kx and kz will be replaced by differential operators.
Thus some terms contain just numbers while others contain operators, and they will be
entered in different physics features. Some patience and attention to details will help a lot
to avoid mistakes. (To compare with Fig. 5 in the paper and for simplicity, let ky stay at
Zero.)

For example, consider the (1,1) element of the matrix F'=A | +A g +A +0. It contains terms
that are just numbers: A; +A 9 +A  +6 .. It also has terms containing the wave vectors kx
and kz, which will be replaced by the differential operators id/dx and id/dz, respectively
(the differentiations here and next are partial derivatives). Note that there is no minus sign
in front of the imaginary unit i because of the engineering sign convention adopted by all
COMSOL physics interfaces: a plane wave is exp(-ikx + iwt), not exp(ikx — iwt). Thus,
the terms for F' that contain differential operators are (hbar?/2m,)(id/dz)(A; + Ag)(id/dz)
and (hbar?/2m,)(id/dx)(Ag + A )(id/dx).

Since these two terms have second-order differentiations, they are entered using the
Second-Order Hamiltonian feature. Each term occupies one row in the Hamiltonian input
table. The position (1,1) in the matrix and the two differentiation operators are specified
by drop-down menus. The A parameters are entered in the input field. A factor of (hbar?/
2m,,) is already included in the feature.
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SCHRODINGER EQUATION (SCHR)
To conveniently create a plot to compare with Fig. 5 in the paper, set the eigenvalue scale
to the same energy unit as the vertical axis (meV), so that the eigenvalue takes on the

numerical value of the eigenenergy in the same unit (meV).
I In the Model Builder window, under Component | (compl) click

Schrodinger Equation (schr).
2 In the Settings window for Schrodinger Equation, locate the Model Properties section.
3 Find the Eigenvalue study subsection. In the Ag,)e text field, type 1[meV].
Second-Order Hamiltonian |: Diagonal F, G, lambda
I In the Physics toolbar, click @ Domains and choose Second-Order Hamiltonian.

2 In the Settings window for Second-Order Hamiltonian, type Second-Order
Hamiltonian 1: Diagonal F, G, lambda in the Label text ficld.

3 Locate the Domain Selection section. From the Selection list, choose All domains.

4 Locate the Hamiltonian section. In the Hamiltonian input table table, enter the following

settings:
Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)

| | A1+A3 F: lambda+theta

Note in the table how one differential operator is located on the left-hand side of the A
parameter and the other one is on the right. In general, such as in heterostructures or
quantum dots, the A parameter can be spatially varying. In those cases, the differential
operator on the left-hand side acts on both the A parameter and the wave function. This
is shown in the Equation section as well. Here for bulk material the A parameter is just
a constant. Now add a row for the other term (hbar?/2m,,)(id/dx)(Ag + A )id/dx).

5 Click |+ Add.
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6 In the Hamiltonian input table table, enter the following settings:

Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)

| | A2+A4 F: lambdat+theta

This finishes the two terms with differential operators for the (1,1) element of the
matrix F. Before entering the terms that are just numbers for F, enter the terms with
differential operators for the (2,2) and (3,3) elements G and A.

The following instructions add the contributions from G and A one row at a time.
Alternatively, it is possible to save some time by copying and pasting. For example, since
the contribution to the second-order Hamiltonian from F'is the same as the one from
G, except the position in the matrix is different — F'is at (1,1) and G is at (2,2), you
can select the two rows for F' in the table by mouse drag, right-click to copy, click on
the Add button to add a new row, and then right-click the first cell of the new row to
paste the two rows that have been copied. After that, change the position of the two
pasted rows from (1,1) to (2,2) and update the description from F to G, leaving the
differential operators and the A parameters the same as the ones for F'.

7 Click + Add.

8 In the Hamiltonian input table table, enter the following settings:

Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)
2 2 A1+A3 G: lambda+theta

9 Click |+ Add.

10 In the Hamiltonian input table table, enter the following settings:

Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)
2 2 A2+A4 G: lambda+theta

Il Click + Add.

12 In the Hamiltonian input table table, enter the following settings:

Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)
3 3 Al lambda

B Click -+ Add.

14 | K-P METHOD FOR STRAINED WURTZITE GAN BAND STRUCTURE



14 In the Hamiltonian input table table, enter the following settings:

Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)
3 3 A2 lambda

The Second-Order Hamiltonian feature that you just finished entering for the diagonal
elements corresponds to the kinetic energy terms normally added by the default Effective
Mass feature. Therefore, disable it to remove the unwanted default contribution to the
Hamiltonian.

Effective Mass |
In the Model Builder window, right-click Effective Mass | and choose Disable.

Now enter the terms that are just numbers for the three diagonal elements F, G, and A.
They are Ay +A g +A ¢ +0  for F, Ay —A g +A ¢ +0  for G, and simply A, for A. For the

diagonal elements, it is easiest to use the default Electron Potential Energy feature.
Electron Potential Energy |: Diagonal F, G, lambda
I In the Model Builder window, click Electron Potential Energy I.

2 In the Settings window for Electron Potential Energy, type Electron Potential
Energy 1: Diagonal F, G, lambda in the Label text ficld.

3 Locate the Electron Potential Energy section. In the V, 1; text field, type Del1+Del2+
Imeps+theps.

4 In the V, 99 text field, type Del1-Del2+1meps+theps.

5 In the V, 33 text field, type 1meps.

You have now finished entering the three diagonal elements F', G, and A. Proceed to enter
the off-diagonal elements. Again, some are just numbers (A) while others have partial

derivatives (K; and H;). Enter them into different features, beginning with the ones with
partial derivatives.

Second-Order Hamiltonian 2: Off-diagonal Kt, Ht
I In the Physics toolbar, click @ Domains and choose Second-Order Hamiltonian.

2 In the Settings window for Second-Order Hamiltonian, type Second-Order
Hamiltonian 2: Off-diagonal Kt, Ht in the Label text field.

3 Locate the Domain Selection section. From the Selection list, choose All domains.
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4 Locate the Hamiltonian section. In the Hamiltonian input table table, enter the following

settings:
Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)

| 2 A5 Kt

5 Click |+ Add.

6 In the Hamiltonian input table table, enter the following settings:

Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)
2 | A5 Kt

7 Click + Add.

8 In the Hamiltonian input table table, enter the following settings:

Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)
| 3 -i*A6 Ht

9 Click |+ Add.

10 In the Hamiltonian input table table, enter the following settings:

Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)
3 | i*A6 Ht

Il Click + Add.

12 In the Hamiltonian input table table, enter the following settings:

Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)
2 3 -i*A6 Ht

B Click -+ Add.

14 In the Hamiltonian input table table, enter the following settings:

Hamiltonian row Hamiltonian column A parameter (1) Description
index (m) index (n)
3 2 i*A6 Ht
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Finally, enter the off-diagonal elements that are just numbers (A) using the Zeroth-Order
Hamiltonian feature. Remember to compensate for the factor of (hbar2/2me) that is

inherent in all Hamiltonian features of this type.
Zeroth-Order Hamiltonian |: Off-diagonal Delta
I In the Physics toolbar, click @ Domains and choose Zeroth-Order Hamiltonian.

2 In the Settings window for Zeroth-Order Hamiltonian, type Zeroth-Order
Hamiltonian 1: Off-diagonal Delta in the Label text ficld.

3 Locate the Domain Selection section. From the Selection list, choosc All domains.

4 Locate the Hamiltonian section. In the Hamiltonian input table table, enter the following

settings:

Hamiltonian row index (m) Hamiltonian column index (n) Description

2 3 Delta

5 Click |+ Add.

6 In the Hamiltonian input table table, enter the following settings:

Hamiltonian row index (m) Hamiltonian column index (n) Description

3 2 Delta

Next, set up the Floquet—Bloch periodic boundary conditions. Use the parameters kx and

kz for the wave vector. Select opposing boundary pairs.

Periodic Condition |

I In the Physics toolbar, click & Boundaries and choosc Periodic Condition.

2 Select Boundaries 1 and 4 only.

3 In the Settings window for Periodic Condition, locate the Periodicity Settings scction.
4 From the Type of periodicity list, choosec Floquet-Bloch periodicity.

5 Specify the kg vector as

kx X
kz Z

Periodic Condition 2
I Right-click Periodic Condition I and choose Duplicate.

2 In the Settings window for Periodic Condition, locate the Boundary Selection scction.

3 Click IL:G Clear Selection.

17 | K-P METHOD FOR STRAINED WURTZITE GAN BAND STRUCTURE



4 Select Boundaries 2 and 3 only.

Now set up the mesh. Since you have created a domain that is much smaller than the
wavelength, there is no need for many mesh elements. In addition, the periodic boundary
conditions require the meshes on the pair of source and destination boundaries to match.

In this case, a simple Mapped Mesh works well.

MESH 1

Mapped |
In the Mesh toolbar, click [l Mapped.

Distribution |

I Right-click Mapped | and choose Distribution.

2 In the Settings window for Distribution, locate the Boundary Selection section.

3 From the Selection list, choose All boundaries.

4 Locate the Distribution section. In the Number of elements text field, type 2.

5 In the Home toolbar, click [EE Build Mesh.

Set up studies to compute the valence band structure for an unstrained and a 1%
compressively strained GaN wurtzite crystal, to be compared to Fig. 5 in the paper. Sweep
the parameter epsxx for the strain. Sweep the parameter kp prepared earlier such that on
its negative axis, kx=0 and kz=-kp, while on its positive axis kz=0 and kx=kp. Use one

study for the Schrodinger equation and a second study for the global equation (analytic

formula).

STUDY I: FIG. 5. SCHRODINGER EQ.
I In the Model Builder window, click Study 1.

2 In the Settings window for Study, type Study 1: Fig. 5. Schrédinger Eq. in the
Label text field.

3 Locate the Study Settings scction. Clear the Generate default plots checkbox.
Step I: Eigenvalue

I In the Model Builder window, under Study I: Fig. 5. Schrodinger Eq. click
Step |: Eigenvalue.

2 In the Settings window for Eigenvalue, locate the Study Settings section.
3 In the Search for eigenvalues around shift text field, type 10.

4 Locate the Physics and Variables Selection section. In the Solve for column of the table,
under Component | (compl), clear the checkbox for Global ODEs and DAEs (ge).
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5 Click to expand the Study Extensions section. Select the Auxiliary sweep checkbox.
6 From the Sweep type list, choose All combinations.
7 Click + Add.

8 In the table, enter the following settings:

Parameter name Parameter value list Parameter unit

epsxx (Strain,xx) 0 -0.01

9 Click |+ Add.

10 In the table, enter the following settings:

Parameter name Parameter value list Parameter unit

kp (Positive axis: kx, negative range(-0.12,0.005,0.12) 1/angstrom
axis: kz)

Il In the Study toolbar, click = Compute.

Create plots to compare to Fig. 5 in the paper, beginning with the unstrained case. Make
one global plot for each band by selecting the appropriate eigenvalue from the list for the
dataset.

RESULTS
Fig. 5. Unstrained
I In the Results toolbar, click ™. 1D Plot Group.

2 In the Settings window for ID Plot Group, type Fig. 5. Unstrained in the Label text
field.

Locate the Data section. From the Dataset list, choose None.
Click to expand the Title section. From the Title type list, choose Label.

Locate the Plot Settings section.

o U1 A W

Select the x-axis label checkbox. In the associated text field, type Negative axis: kz
Positive axis: kx (1/angstrom).

7 Select the y-axis label checkbox. In the associated text field, type Energy (meV).
8 Locate the Axis section. Select the Manual axis limits checkbox.

9 In the x minimum text field, type -0.12.

10 In the x maximum text field, type 0.12.

Il In the y minimum text field, type -100.
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12 In the y maximum text field, type 50.
Global | - Schrédinger Eq. HH
I Right-click Fig. 5. Unstrained and choosc Global.

2 In the Settings window for Glebal, type Global 1 - Schrédinger Eq. HH in the Label
text field.

3 Locate the Data section. From the Dataset list, choose Study I: Fig. 5. Schrodinger Eq./
Solution | (soll).

4 From the Parameter selection (epsxx) list, choose First.

5 From the Eigenvalue selection list, choose Last.

6 Locate the y-Axis Data section. Click Y Clear Table.

7 In the table, enter the following settings:

Expression Unit Description
lambda HH

8 Locate the x-Axis Data section. From the Parameter list, choose Expression.
9 In the Expression text field, type kp/1[angstrom”-1].

Global | - Schridinger Eq. LH

I Right-click Global I - Schrodinger Eq. HH and choosc Duplicate.

2 In the Settings window for Glebal, type Global 1 - Schrédinger Eq. LH in the Label
text field.

3 Locate the Data section. From the Eigenvalue selection list, choose Manual.
4 In the Eigenvalue indices (1-3) text field, type 2.

5 Locate the y-Axis Data section. In the table, enter the following settings:

Expression Unit Description

lambda LH

Global | - Schrédinger Eq. CH
I Right-click Global | - Schrédinger Eq. LH and choose Duplicate.

2 In the Settings window for Glebal, type Global 1 - Schrédinger Eq. CHin the Label
text field.

3 Locate the Data section. From the Eigenvalue selection list, choose First.
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4 Locate the y-Axis Data section. In the table, enter the following settings:

Expression Unit Description

lambda CH

Duplicate the plot for the strained case. Change the plot label and the selection of the

strain parameter epsxx.

Fig. 5. -1% Strained

I In the Model Builder window, right-click Fig. 5. Unstrained and choose Duplicate.

2 In the Settings window for ID Plot Group, type Fig. 5. -1% Strained in the Label text
field.

Global | - Schrédinger Eq. HH
I In the Model Builder window, expand the Fig. 5. -1% Strained node, then click Global I -
Schrodinger Eq. HH.

2 In the Settings window for Gloebal, locate the Data section.

3 From the Parameter selection (epsxx) list, choose Last.

Global | - Schridinger Eq. LH

I In the Model Builder window, click Global I - Schrédinger Eq. LH.
2 In the Settings window for Global, locate the Data section.

3 From the Parameter selection (epsxx) list, choose Last.

Global | - Schrédinger Eq. CH

I In the Model Builder window, click Global | - Schrodinger Eq. CH.
2 In the Settings window for Global, locate the Data section.

3 From the Parameter selection (epsxx) list, choose Last.

Now set up a study to solve the analytic 3-by-3 matrix equation configured with the global

equation. Use the All eigenvalue option to obtain all three eigenvalues of the 3-by-3

matrix equation.

ADD STUDY
I In the Home toolbar, click :\‘j:i Add Study to open the Add Study window.

2 Go to the Add Study window.
3 Find the Studies subsection. In the Select Study tree, select Empty Study.
4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click "\‘j:i Add Study to close the Add Study window.
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STUDY I: FIG. 5. SCHRODINGER EQ.

Step I: Eigenvalue
In the Model Builder window, under Study I: Fig. 5. Schrodinger Eq. right-click
Step |: Eigenvalue and choose Copy.

STUDY 2: FIG. 5. ANALYTIC
I In the Model Builder window, click Study 2.

2 In the Settings window for Study, type Study 2: Fig. 5. Analytic in the Label text
field.

3 Locate the Study Settings scction. Clear the Generate default plots checkbox.

4 Right-click Study 2: Fig. 5. Analytic and choose Paste Eigenvalue.

I In the Settings window for Eigenvalue, locate the Study Settings section.
2 From the Eigenvalue solver list, choose LAPACK (filled matrix).

3 Locate the Physics and Variables Selection scction. In the Solve for column of the table,

under Component | (compl), clear the checkbox for Schrédinger Equation (schr).

4 In the Solve for column of the table, under Component | (compl), sclect the checkbox
for Global ODEs and DAEs (ge).

5 Locate the Study Extensions section. In the table, enter the following settings:

Parameter name Parameter value list Parameter unit
kp (Positive axis: kx, negative range(-0.12,0.01,0.12) 1/angstrom
axis: kz)

6 In the Study toolbar, click = Compute.

Add the analytic solution to the two plots to compare with the numerical solution.

RESULTS

Global | - Analytic
I In the Model Builder window, right-click Global I - Schrédinger Eq. CH and choose
Duplicate.

2 In the Settings window for Glebal, type Global 1 - Analytic in the Label text field.

3 Locate the Data section. From the Dataset list, choose Study 2: Fig. 5. Analytic/
Solution 2 (sol2).

4 From the Eigenvalue selection list, choose All.
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5 Locate the y-Axis Data section. In the table, enter the following settings:

Expression Unit Description

lambda Analytic

6 Click to expand the Coloring and Style scection. Find the Line style subsection. From the
Line list, choosec None.

7 Find the Line markers subsection. From the Marker list, choose Circle.

8 In the Fig. 5. Unstrained toolbar, click Plot.

Fig. 5. Unstrained

50 T T T T T
40 — HH .
30k — LH i
— CH
O Analytic

Energy (meV)

-100 1 1 1 1 1
-0.1 -0.05 0 0.05 0.1
Negative axis: kz Positive axis: kx (1/angstrom)

9 Right-click Global I - Analytic and choose Copy.

Global | - Analytic

I In the Model Builder window, right-click Fig. 5. -1% Strained and choose Paste Global.
2 In the Settings window for Gloebal, locate the Data section.

3 From the Parameter selection (epsxx) list, choose Last.
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4 In the Fig. 5. -1% Strained toolbar, click Plot.

Fig. 5. -1% Strained
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Add a new study to compute the 2D band structure in the kx-kz plane, first using the

Schrodinger equation.

ADD STUDY

I In the Home toolbar, click \)i Add Study to open the Add Study window.
2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, sclect Empty Study.
4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click \)i Add Study to close the Add Study window.

STUDY 3: 2D DISPERSION SCHRODINGER EQ.

I In the Settings window for Study, type Study 3: 2D Dispersion Schrédinger Eq.
in the Label text field.

2 Locate the Study Settings scction. Clear the Generate default plots checkbox.
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STUDY I: FIG. 5. SCHRODINGER EQ.

Step I: Eigenvalue
In the Model Builder window, under Study I: Fig. 5. Schrodinger Eq. right-click
Step |: Eigenvalue and choose Copy.

STUDY 3: 2D DISPERSION SCHRODINGER EQ.

In the Model Builder window, right-click Study 3: 2D Dispersion Schrédinger Eq. and choose
Paste Eigenvalue.

I In the Settings window for Eigenvalue, locate the Study Extensions section.

2 In the table, enter the following settings:

Parameter name Parameter value list Parameter unit
kx range(0,0.1,1)*0.07 1/angstrom
kz range(0,0.1,1)*0.07 1/angstrom

3 In the Study toolbar, click = Compute.

Create one table for each band to plot the 2D band structure using the Table Surface plot
type for the three hole bands. First the heavy hole band (HH).

RESULTS
Evaluation Group I: HH
I In the Results toolbar, click Evaluation Group.

2 In the Settings window for Evaluation Group, type Evaluation Group 1: HHin the
Label text field.

3 Locate the Data section. From the Dataset list, choose

Study 3: 2D Dispersion Schrodinger Eq./Solution 3 (sol3).
4 From the Eigenvalue selection list, choose Last.
Global Evaluation |: Schrédinger eq.
I Right-click Evaluation Group I: HH and choose Global Evaluation.

2 In the Settings window for Global Evaluation, type Global Evaluation 1:
Schrddinger eq. in the Label text field.

3 Locate the Expressions section. Click L Clear Table.
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4 In the table, enter the following settings:

Expression Unit Description

lambda HH (Schr)

5 In the Evaluation Group I: HH toolbar, click = Evaluate.

EVALUATION GROUP I: HH

I Go to the Evaluation Group I: HH window.

2 Click the Table Surface button in the window toolbar.

RESULTS

Table Surface I: HH (Schr)
I In the Settings window for Table Surface, type Table Surface 1: HH (Schr) in the
Label text field.

2 Locate the Data section. From the Data column list, choose HH (Schr).

Height Expression |
Right-click Table Surface I: HH (Schr) and choose Height Expression.

2D Band Structure, -1% Strained
I In the Settings window for 2D Plot Group, type 2D Band Structure, -1% Strained
in the Label text field.

2 Click to expand the Title section. From the Title type list, choose Label.

Then the light hole band (LH).

Evaluation Group 2: LH

I In the Model Builder window, right-click Evaluation Group I: HH and choose Duplicate.

2 In the Settings window for Evaluation Group, type Evaluation Group 2: LHin the
Label text field.

3 Locate the Data section. From the Eigenvalue selection list, choose Manual.
4 In the Eigenvalue indices (1-3) text field, type 2.
Global Evaluation |: Schrodinger eq.

I In the Model Builder window, expand the Evaluation Group 2: LH node, then click

Global Evaluation I: Schrédinger eq..

2 In the Settings window for Global Evaluation, locate the Expressions section.
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3 In the table, enter the following settings:

Expression Unit Description
lambda LH (Schr)
4 In the Evaluation Group 2: LH toolbar, click = Evaluate.

Table Surface 2: LH (Schr)

|
2

In the Model Builder window, right-click Table Surface I: HH (Schr) and choose Duplicate.

In the Settings window for Table Surface, type Table Surface 2: LH (Schr) in the
Label text field.

Locate the Data section. From the Evaluation group list, choose Evaluation Group 2: LH.

Click to expand the Inherit Style section. From the Plet list, choose
Table Surface I: HH (Schr).

Then the crystal-field split-off hole band (CH).

Evaluation Group 3: CH

|
2

3

In the Model Builder window, right-click Evaluation Group 2: LH and choose Duplicate.

In the Settings window for Evaluation Group, type Evaluation Group 3: CHin the
Label text field.

Locate the Data section. From the Eigenvalue selection list, choose First.

Global Evaluation |: Schrodinger eq.

In the Model Builder window, expand the Evaluation Group 3: CH node, then click

Global Evaluation I: Schrodinger eq..

2 In the Settings window for Global Evaluation, locate the Expressions section.
3 In the table, enter the following settings:

Expression Unit Description

lambda CH (Schr)

4 In the Evaluation Group 3: CH toolbar, click = Evaluate.

Table Surface 3: CH (Schr)

|
2

3
4

In the Model Builder window, right-click Table Surface 2: LH (Schr) and choose Duplicate.

In the Settings window for Table Surface, type Table Surface 3: CH (Schr) in the
Label text field.

Locate the Data section. From the Evaluation group list, choose Evaluation Group 3: CH.

In the 2D Band Structure, -1% Strained toolbar, click Plot.
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Finally, set up a study to compute the 2D band structure in the kx-kz plane using the
global equation of the analytic formula.

ADD STUDY
I In the Home toolbar, click :\‘j:i Add Study to open the Add Study window.

2 Go to the Add Study window.
3 Find the Studies subsection. In the Select Study tree, sclect Empty Study.
4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click "\‘j:i Add Study to close the Add Study window.

STUDY 4: 2D DISPERSION ANALYTIC

I In the Settings window for Study, type Study 4: 2D Dispersion Analytic in the
Label text field.

2 Locate the Study Settings scction. Clear the Generate default plots checkbox.

STUDY 3: 2D DISPERSION SCHRODINGER EQ.

Step I: Eigenvalue
In the Model Builder window, under Study 3: 2D Dispersion Schrédinger Eq. right-click
Step I: Eigenvalue and choose Copy.

STUDY 4: 2D DISPERSION ANALYTIC

In the Model Builder window, right-click Study 4: 2D Dispersion Analytic and choose
Paste Eigenvalue.

I In the Settings window for Eigenvalue, locate the Study Settings section.

2 From the Eigenvalue solver list, choose LAPACK (filled matrix).

3 Locate the Physics and Variables Selection section. In the Solve for column of the table,
under Component | (compl), clear the checkbox for Schrédinger Equation (schr).

4 In the Solve for column of the table, under Component | (compl), sclect the checkbox
for Global ODEs and DAEs (ge).

5 In the Study toolbar, click = Compute.
Similarly create one table for each band to plot the analytic 2D band structure using the
Table Surface plot type for the three hole bands. Use the Wireframe option for the analytic

result to compare to the numerical result by overlaying the plotted surfaces. First the heavy
hole band (HH).
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RESULTS

Global Evaluation 2: Analytic
I In the Model Builder window, right-click Global Evaluation I: Schrédinger eq. and choose

Duplicate.

2 In the Settings window for Global Evaluation, type Global Evaluation 2: Analytic
in the Label text field.

3 Locate the Data section. From the Dataset list, choose Study 4: 2D Dispersion Analytic/
Solution 4 (sol4).

4 From the Eigenvalue selection list, choose Last.

5 Locate the Expressions section. In the table, enter the following settings:

Expression Unit Description

lambda HH (Anal)

6 In the Evaluation Group |: HH toolbar, click = Evaluate.
Table Surface 4: HH (Anal)
I In the Model Builder window, right-click Table Surface I: HH (Schr) and choose Duplicate.

2 In the Settings window for Table Surface, type Table Surface 4: HH (Anal) in the
Label text field.

Locate the Data section. From the Data column list, choose HH (Anal).
Locate the Coloring and Style section. From the Coloring list, choose Uniform.
From the Color list, choose Gray.

Select the Wireframe checkbox.

Locate the Inherit Style section. From the Plot list, choose Table Surface 1: HH (Schr).

0 N O U1 AW

Clear the Color checkbox.
Then the light hole band (LH).

Global Evaluation 2: Analytic
I In the Model Builder window, right-click Global Evaluation I: Schrédinger eq. and choose

Duplicate.

2 In the Settings window for Global Evaluation, type Global Evaluation 2: Analytic
in the Label text field.

3 Locate the Data section. From the Dataset list, choosc Study 4: 2D Dispersion Analytic/
Solution 4 (sol4).

4 From the Eigenvalue selection list, choose Manual.
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5 In the Eigenvalue indices (1-3) text field, type 2.

6 Locate the Expressions section. In the table, enter the following settings:

Expression Unit Description

lambda LH (Anal)

7 In the Evaluation Group 2: LH toolbar, click = Evaluate.
Table Surface 5: LH (Anal)
I In the Model Builder window, right-click Table Surface 4: HH (Anal) and choose Duplicate.

2 In the Settings window for Table Surface, type Table Surface 5: LH (Anal) in the
Label text field.

3 Locate the Data section. From the Evaluation group list, choose Evaluation Group 2: LH.
Then the crystal-field split-off hole band (CH).

Global Evaluation 2: Analytic
I In the Model Builder window, right-click Global Evaluation I: Schrédinger eq. and choose

Duplicate.

2 In the Settings window for Global Evaluation, type Global Evaluation 2: Analytic
in the Label text field.

3 Locate the Data section. From the Dataset list, choose Study 4: 2D Dispersion Analytic/
Solution 4 (sol4).

4 From the Eigenvalue selection list, choose First.

5 Locate the Expressions section. In the table, enter the following settings:

Expression Unit Description

lambda CH (Anal)

6 In the Evaluation Group 3: CH toolbar, click = Evaluate.
Table Surface 6: CH (Anal)
I In the Model Builder window, right-click Table Surface 5: LH (Anal) and choose Duplicate.

2 In the Settings window for Table Surface, type Table Surface 6: CH (Anal) in the
Label text field.

3 Locate the Data section. From the Evaluation group list, choose Evaluation Group 3: CH.
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Plot.

4 In the 2D Band Structure, -1% Strained toolbar, click

Use mouse drag to rotate the energy surfaces around to take a look.

2D Band Structure, -1% Strained
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